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Glossary
The following are a glossary of terms associated with WindiGO:
The Board 
The Stones 
Handicap Game 
Capture 
Tool Bar 
Registered User
Shareware



The Board
The board is a grid of 19x19 lines, forming 361 intersection points.    On the board there 
are nine star points.    The columns are labeled A-H, J-T starting in the upper left hand 
corner.    The rows are labeled 1-19 starting in the lower left hand corner.    



The Stones
361 stones ( 180 are white and 181 are black ).    In playing the game, black and white 
stones are used, and the stronger player uses white stones.



Handicap Game
The weaker player plays Black and therefore goes first.    This is considered to give the 
weaker player a slight advantage.    If the player is much weaker he or she can be 
compensated by obtaining a 2 to 9 stone advantage.

A player moves up or down in handicap after winning or losing three consecutive games 
to the same opponent.    For example, if Player A loses to Player B three times in a row, 
the handicap moves one notch in A's favor, either A's handicap increases or, if B had the 
handicap, B's handicap reduces by one.

The Black player does not have a choice where the extra stones are placed.    The Black 
stones are placed symmetrically around the board on the star points.    For additional 
information see the Handicap menu command.



Capture
When all of the intersections adjacent to a stone or a group of stones are occupied by 
stones of the opponent, that stone or group of stones is considered captured and is 
removed from the board.    



Tool Bar
The tool bar provides you with quick access to commonly used menu commands.



Registered User
A registered user is one that has paid the registration fee and is running a registered 
copy of this software application.    See Registration Information for information on 
registering.



Shareware
Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register.    The authors are
not compensated for their efforts unless you register.    Copyright laws apply to both 
Shareware and commercial software, and the copyright holder retains all rights.    
Shareware is a distribution method, not a type of software.    The Shareware system 
makes fitting your needs easier, because you can try before you buy.





How To Play Go
The following topics will assist you in learning how to play Go:
Object of the Game 
Rules of Play 
Captured Stones 
Illegal Play Rule 
Safe Territory 
Situations 
Scoring 

Strategies - 
Opening Moves 
Basic Tactics 



Object of the Game
Go is a game played between two players.

The object of Go is to secure territory as represented by the number of the unoccupied 
points of intersection .    At the end of the game, the amount of vacant space is 
calculated, and the stones that have been captured are used to fill up the vacant spaces 
claimed by the opponent.    The winner is the player who has succeeded in occupying the 
larger territory after the captured stones are used in this way.

With this ultimate object in view, two plans of action are followed, one being simply to 
rail off space by forming walls of stones around the area which the player desires to 
occupy, and the other that of capturing the stones    or space of the opponent.    The 
game is concluded when 1. a player runs out of stones; or, 2. neither player is able to 
secure further unoccupied territory and when neither is willing to hazard further attacks 
on the territory already surrounded by his opponent - this occurs when both players Pass.
    



Rules of Play
1. The stones are played on the points of intersection    of the lines.    Once placed they 
are not moved except when captured .
2. The weaker player gets the black stones and the first move.    The players now 
alternate turns; except in the case of a handicap game .
3. When all of the intersections adjacent to a stone or a group of stones are occupied by 
stones of the opponent, that stone or group of stones is captured and removed. 
4. It is forbidden to play on any point which is completely surrounded by the opponent's 
stones and there is only the one point vacant, unless the play results in the capture of all
or part of the surrounding stones, because no stone may remain on the board if it is 
completely surrounded by stones of the opposite color - in other words, suicide is illegal.
5. If a group of stones contains two separate "eyes," it is permanently safe from capture, 
regardless of the enemy stones surrounding the group.        
6. In a ko position, a player cannot repeat his previous move without first playing at 
some other part of the board.
7. The game is concluded when 1. a player runs out of stones; or, 2. neither player is 
able to secure further unoccupied territory and when neither is willing to hazard further 
attacks on the territory already surrounded by his opponent - this occurs when both 
players Pass.



Captured Stones
When all of the intersections adjacent to a stone or a group of stones are occupied by 
stones of the opponent, that stone or group of stones is considered captured and is 
removed from the board .    

The following diagram shows one white stone in the upper left corner.    To capture this 
single stone, all of the four points immediately adjacent to that stone (on the horizontal 
and vertical axis), which are called "liberties" of the stone, must be occupied by black 
stones, as shown in the upper central part of the diagram.    When this condition is met, 
the white stone is removed from the board by the black player as a captive.    The upper 
right hand corner of the diagram shows the position after the capture and removal.

The central left hand corner of the diagram shows four black stones, each on a diagonal 
from the one white stone.    Since the liberties of a stone only apply on the horizontal and
vertical axis, the white stone still has four open liberties.    The other figures in the center 
of the diagram demonstrate how a stone can obtain additional number of liberties by 
being connected horizontally and vertically with stones of a like color.

The bottom portion of the diagram shows a few examples in which a group of 
single/connected white stones become captives.



Illegal Play Rule
You are not allowed to place a stone on a point which is completely surrounded by your 
opponent's stones - suicide is illegal.    This rule can be ignored if the placement of your 
stone allows you to capture all or part of the surrounding stones.

The upper part of the following diagram displays three examples where White is not 
allowed to place a piece.    A White placement in each of the positions where the white 
stone with the red outer rim is located would be "suicide" - and thus, illegal.    The lower 
part of the diagram displays two examples which appear to be "suicide" for White but are
really legal moves.    In each of these examples, White's placement (the white stone with 
the red outer rim) allows it to capture Black pieces.



Safe Territory
In order for a group of stones to be truly safe, they need to have two or more points on 
which the illegal play rule    applies.    The diagram shows some examples of Black's "live"
positions, with each group having two eyes.    An "eye" is a vacant point.    With each of 
these positions, White cannot surround the black stones and attempt to capture them.    
For in order to do that, it would have to break the illegal play rule.    

The left hand side of the following diagram displays false eyes for the black stones.    
These are unsafe territories.    White can capture these black stones.    On the left hand 
side, if Black was able to replace the white stone with the red outer rim with a black 
stone, the Black territories would then be safe.    The right hand side of the diagram 
shows where White would be able to play (the white stone with the red outer rim) in 
order to capture the black stones with the red outer rim.    White is able to do this without
breaking the illegal play rule.





Scoring
1. Every vacant intersection inside your territories counts for one point.
2. You also get one point for every stone you capture during the game

From this information you can get a rough idea of the score.    You can obtain this 
information from the Status Window.    Scoring basically falls into two camps.    Your score 
is either the number of pieces you have on the board + the number of vacant points you 
surround OR it is the number of vacant points you surround - the number of pieces 
captured by your opponent.    These two systems are potentially equivalent, meaning 
that although they don't provide the same score, anyone who wins under one system 
would win under the other system as well.

If a group or a single stone is surrounded by enemy stones in such a way that it cannot 
avoid capture ( even though it may have several liberties), it is said to be dead.    At the 
end of the game the player surrounding a dead group removes these stones as if they 
had been captured and you would proceed with the normal counting rules.    Stones are 
"dead" only if both players regard them as such.    Their owner is quite entitled to try and 
save them, even if he is wasting his time.



Opening Moves
Opening moves should be played at strategic points , to map out prospective territories . 
The game typically starts with the players "staking out" territory around the board's star 
points.    The corners are the easiest areas in which to form territory and the simplest to 
defend.    The next most advantageous sections are the sides, while the center of the 
board is the most difficult area in which to form territory.    The following diagram shows 
an example of an opening move procedure. 

Black's play in the upper left corner is similar to the knight's move in chess.    If the 
stones are one point farther apart, what white has done in the upper right corner, this is 
called the "great knight's move".    The placement illustrated in the lower left corner is 
called "skipping one point."    Note: in each of these three scenarios, the moves were 
centered around surrounding a "start point".    The placement in the lower right corner is 
called "skipping two points" and this move also demonstrates how you can protect a 
"star point" by placing a stone on it.    Once the corners were "staked" out the players 
moved on to the sides; e.g. moves 9-12.



Basic Tactics
Corner, Side, then Center
You should extend from the corners you occupy to the side, rather than just play 
anywhere on the side.    And then you should advance towards the center by extending 
from your side positions.    

Start on the 3rd and 4th lines
You should appreciate that a stone on the 4th line is looking towards the center, while a 
stone on the 3rd line is oriented towards territory on the edge.

You should also realize that it is bad to allow your opponent to seal off side territory on 
the 4th line, and that at the beginning it is a waste of time to make territory on the 
second line.    It is better to stake out territories loosely than to form impenetrable walls 
around one corner.

 





A Description of the Software
How to start a new game 
How to open a game in progress 

Menu Commands
File Menu

New 
Open 
Save 
Save As 
Wait 
Exit 

Edit Menu
Undo 
Handicap 
Pass
Comment 
Set-Up 
Practice Mode 
Status Window 



How to start a new game
There are three modes of play that this program supports: single PC, LAN, and eMail 
(Remote PC). Which method you use will depend largely upon where your opponent is.    
Each mode is interchangeable.    You can start in one mode and finish via another; e.g. 
one can play a game on a single PC, continue it over the LAN, and then take the game 
home and play by sending the game file to your opponent via a modem.

Once you have an opponent you must determine who will go first.    Generally the weaker
player goes first.    Then to start a new game simply select New from the file menu.    An 
empty Go board    should be created along with the tool bar .

At this point you might want to use Set-Up    from the Edit menu to set the player names. 

Also, if the weaker player will receive a handicap then you would now set the handicap 
by selecting Handicap from the Edit menu.    Selecting a handicap gives the first player a 
2 to 9 stone head start by placing the stones in pre-determined positions.

If there will be no handicap, you're now ready to make the first move as is indicated by 
the cursor which is supposed to be a hand holding a black piece.    Select an intersection 
point    with the mouse and click the left mouse button.    This places a black stone on that
intersection.

At this point, handicap or not, it is the white players move as indicated by the cursor 
which is now holding a white piece.    What you do now depends on the mode of play.

Single PC mode:

Either hand the mouse to your opponent or, if your opponent will make a move at a later 
time, save the game using Save (or Save As ) from the file menu.    Your opponent will 
have to know the name and location of the file to re-open the game.    In this mode, 
players take turns making moves on the same PC.

LAN mode:

You would either select Save (or Save As) or Wait from the File menu.    Save the game if 
you are going to close the program.    Use Wait if you and your opponent will be playing 
interactively.    Your opponent would then open the game on his/her PC.    This mode 
assumes separate PCs which are connected via a network and have common access to 
the game file.    In this mode a player goes into a "wait" state, via the Wait command, in 
order to relinquish the turn to the opponent.    If it is not your turn, you are in a "wait" 
state.    

eMail (Remote PC) mode:



Save the game using Save (or Save As) from the File menu.    The game file is in text 
format and can be mailed/delivered through any eMail system.    This mode assumes 
separate PCs which are not connected.    This mode operates in the same way as the LAN
mode except the game file must be "delivered" to the other PC after a move has been 
made.



How to open a game in progress
To open a game in progress select Open from the file menu.    You will then get a fairly 
standard file open dialog box with which you can select the game file desired.    If you 
have previously "opened" some games, the bottom portion of the file menu will list the 
last four games you played.    You can automatically open a previous game by selecting 
one of the items from this list.

When you open a game in progress you will get a dialog box telling you whose turn it is 
and giving you the option of Continuing or Waiting.    You would only wait if you are 
playing on a LAN, it is not your turn and you want to be notified when your opponent 
moves.    Otherwise select continue.



If you selected "continue", you will now be informed of your opponents last move.

You can now make your move.    Otherwise, if you selected "wait", you are now in a "wait 
" state.

You can create an icon for the the WindiGo game in one of your Windows program 
groups.    There are two command line arguments which you can add: 1. the game file 
name, and, 2. your user name or color.    For example, using the following command line 
c:\game\go.exe game1.go WHITE. automatically opens the game1.go game file and 



informs WindiGo that you are WHITE.    Both command line arguments are optional.    The 
user name or color command argument must follow the game file command argument if 
you plan on using it.



Undo - menu command
Undo undoes the last unsaved move.    Undo will not be possible after saving the game or
entering wait mode.    Either of those actions commit the last made move.



Handicap - menu command
Handicap gives an advantage to the weaker player by giving that player a 2 to 9 stone 
head start.    It can only be used on a New game, that is, a game with no previous moves.



Comment - menu command
Comment is used to send a short comment to your opponent.    Comments are sent as 
attachments to moves.    There is no way to send just a comment.    The comment will be 
seen the next time your opponent opens the game or makes his/her move.



Set-up - menu command
Set-Up allows you to set options such as the player names and the polling time (used 
when you are in the LAN playing mode ).    It also allows you to specify the backup 
directory.    The default backup directory is the same directory the current game file is 
located at.    The Set-Up information is specific to a game.



Practice Mode - menu command
Practice mode places you into a practice session.    During practice mode you may place 
visually distinct stones on the board to experiment with ideas.    None of the stones count
as a move and they are all removed when you leave practice mode.

Stones of your color are dropped with the left mouse button.    Stones of the opponent's 
color are dropped with the right mouse button.    You clear a stone, practice or real, by 
trying to place a practice stone on top of it.    



Status Window - menu command
Status window toggles a window of the same name.    This window gives statistics about 
the currently loaded game    These statistics give you an idea how well you are doing.    
This window also displays the comment field.    See Scoring . 



New - menu command
New is used to start a new game.    If a game is currently loaded it must be saved 
because it is not possible to have two games loaded at once.



Open - menu command
Open is used to continue a game that is already in progress. If there is already a game in 
memory it will have to be saved because it is not possible to load multiple games.



Save - menu command
Save is used to save the currently loaded game.    In order to save a game at least one 
move had to be made.    If the game has not been given a file name yet you will be 
presented with a dialog box so you may give it one. 



Save As - menu command
Save as is used to save the currently loaded game under a new name. 



Wait - menu command
Wait is only used for games that are being played over a LAN.    It is similar to Save in 
that it writes the current state of the game out to the game file.    The difference is that 
the game then goes into a "wait" mode until your opponent makes a move and selects 
Wait.    While in the "wait" state, you can Exit the game or enter Practice mode .



Exit - menu command
Exit closes the program.    If the currently loaded game has unsaved moves you will be 
given a chance to save the game. 



Pass
Pass will allow you to forgo your turn and allow your opponent to make another move.

 





Situations
Atari 
Ko 



Atari
A player is in "atari" if one of his stones or group of stones is or are in a state of being 
"checked" (similar to chess); i.e. one more of the opponent's stones means death for the 
player's stones.

In the following diagram, the two figures on the left show the white stones are under the 
threat of being captured by Black's one more move.    The figures in the center of the 
diagram show's the Black move - the black stone with the red outer rim - which would 
capture the group of white stones.    The figures to the right show what White can do to 
save his stone or stones from being captured; e.g. extending White's liberties.



Ko
Both players are in a ko situation when they could capture/re-capture each others stones 
on successive moves.    This could be an endless loop.    In order to allow the game to 
continue, the following rule was established when a player has captured an enemy stone 
in a ko position, his opponent may not recapture until he first makes at least one play 
elsewhere on the board.

The following diagram demonstrates a ko situation.    The figure in the upper left hand 
corner shows one white stone in atari, therefore, Black may capture it if he wishes.    The
figure to it's right shows the aftermath of Black's capture - the black stone with the red 
outer rim. This also shows that the black stone with the red outer rim is now placed in an 
atari situation.    Due to the ko rule, White is not allowed to retake the Black piece until he
has played elsewhere on the board first.    The third figure shows White - the white stone 
with the red outer rim, immediately retaking the Black stone - as you can see, this 
reverts to the formation shown in the first figure on the left of the diagram - an endless 
loop could occur; thus, the ko rule was created.    White could break the ko situation as 
demonstrated in the figure in the lower left part of the diagram.

 



Technical Support Information
We will provide technical support to un-registered users on a limited basis.    All 
registered users are entitled to 100 days of free technical support.

You can reach us via US mail at the following address:

Lemanowicz & Miranda
3330 Forest Overlook Drive
Seven Hills, OH 44131 USA

You can also reach us via:

Internet: db385@cleveland.freenet.edu
Compuserve: 72142.2367@CompuServe.com
 



Registration Information
This WindiGO application is a "Shareware" program.    You are encouraged to try it for 
free.    You are also encouraged to pass it along, unaltered, to anyone else you feel 
may be interested.    

If, after a reasonable time you decide to continue using it please register it by sending $24.95 to 
Lemanowicz & Miranda, at the address listed below.    Please specify your name, return address, and the 
type of floppy diskette you prefer when you send in your registration.    Also, we are interested in finding 
out what features you would like to see in future releases.    The file GO_REG.FRM may be printed out and
used for registering.    

You will be sent the latest, registered version of the WindiGO application.    Your registration will also 
entitle you to 100 days of free technical support.    You will also be notified of, and be eligible for a discount
on, any possible future versions of WindiGO.    More information about shareware and liability is available 
in the GO_RDME.TXT file.    Any correspondence should be addressed to:

Lemanowicz & Miranda
3330 Forest Overlook Drive
Seven Hills, OH 44131 USA





General Information
New Topic text goes here.




